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1. Crankcase Oil Level
2. Engine Belts [;_1
3. Plug Wires

4. Brake Fluid Level

5. Hydraulic Fluid Level

6. Fuel Tank Level

7. Tire/'Wheel Rim Condition
8. Headlights/Tail Lights

9. Tum Signals

10. Waming Lights

11. Hour Meter

12. Other Gauges
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13. Forks for Damage
14, Mast, Chains, Hydraulic Lines

N

|

Security Stalf
On-The-Job Training Checklisi

Employes: Emgployes ID #:

Tithe: First Day of Employment:
SUpeTVISor: Title:

Date OJT E-n-Ein:: Drafe DT Enads:

CPRFirsl Aid Expiralion Dabe: af CPRFirst Ald Training Dale:

Tz by compipdnd by s, Famshomed and re-aiagred sacurly smplomes
All sechons bo be completed by Supervisor or On-Gfe Traming Coordenator (0TC)
DATE EmpLOYEE | SUPERVISOR

COMPLETED |  IMITIALS or OTC
BATIALS |

ToPIC

A, WELCOME TO NEW EMPLOYEE

By Wesassn | Visson

Chl Cooere Waluos
il W ety Berpeeimnl Goals

LS| 3

4 | Siandard of comdiact | albics

5 M ol Exscidnee Cndes [sas Allachment L ol 850527

6 |Irlroedisstan ol slall

« |Cruain of Comrmand | Orgarsrabonal Chaet of Racility'otlce and
agancy (nel, regons & dinets)

B | Mo ol anbog Lacidy
B. DRESRS CODE

i |Undormed stafl deess code (DU podicy) i
C. GENERAL SAFETY AMD SECURITY
1 |Wiapwr pial oraprdabicn vidoos

2 || v o orendaison veos

3 |Supersion of Y.oulh

d |Seanchas

Lrordraband [From ol stal and sigdors)
6 || Foeod Cananfiecdl PaneCaschionns

L

T [|Hiay ol Proceduns

B |Awareness of Electrons: Mondonng Syslem (Detor o Guardman)
G

Awarenest o Loanf PeorddodBh Alioo]irkabety of Wosith

0] Yonath Klsserataril

11| Teansganng o Estrtng Yool
12| Uise of ogbooks

D. INTAKE

i |Gararal intaon procedures

2 |Clarssdication of youth

3 (Medicad inlake Screerang
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We’ve all had those days when our to- do list seems endless and that was before we had an Excel checklist template. In the old days, we had whiteboards and sticky notes as our aids; we’ve since moved on to smarter methods to create a prioritized to-do list.One of the earliest and most basic options for creating a to-do list was Microsoft Excel. In this
article, we’ll walk you through how to make a list in excel, and introduce you to a flexible alternative— monday.com Work OS.We’ll also look at an alternative option — monday.com Work OS — to see if we’re any better or faster.Get started with monday.comWhat is the function of an Excel checklist template?When you find yourself juggling multiple
items in your head, it’s incredibly difficult to assign priority to the tasks. A to-do list’s purpose is to make sense of this information.Download to excelThe simple—and outdated—solution is to put pen to paper and then decide the order you should tackle each task. You check each off as you go, and then the note usually gets tossed in the bin.There are
some clear downfalls here:1) If you assign the wrong priority to an item, all of these changes will result in some pretty messy paper and leaves literal room for notes, changes, and more.2) Once you’ve crumpled the to-do list, you have no record of progress made against the list.3) It’s very difficult to share this list with others in a professional
setting.The world is your to-do list oyster— there is a wide array of apps and software out there who’s aim is to help you organize your to-do list in a way that works for you.Microsoft Excel is just one of them and it’'s sometimes favored because:It’s a familiar software, so almost anybody who has used Microsoft Office will be able to create a to-do list
easilyAnyone can access an Excel list template and use features like conditional formatting that combine with reporting tools such as charts and matrices. Pivot tables can be used to customize data if required.Let’s get building. Get started How to create a simple to-do list in ExcelThis whole process revolves around using Excel’s Filter feature to
create an editable, trackable list that you can format according to your preference.Step 1: open Excel and add column headersOpen a new Excel spreadsheet and enter new column headers.I’ve added the following:Task nameStatusDeadlineNoteYou could add additional columns as needed such as budget, owner, tools, etc.Step 2: fill in task
details.Add your tasks in the column, the status of each, and a deadline.In the table below you’ll find:Monthly report — ongoingConfirm venue reservation — pendingSend thank you note to event attendee — doneFinancial report — doneNote that you must fill out the tasks and status columns so that the filter can be applied. The other fields can be
filled out at a later stage.Get startedStep 3: apply a filter to your list.To add a filter to your list, simply click on one of the headers and select Filter under the Sort & Filter icon on the top right corner of your Taskbar.Once you save the file, Excel will remember this and the filter will be there the next time you open the file.Step 4: sort your tasks using
the filter.You’ll now be able to see tiny arrows on the headers of your column.Click on the arrow to sort your tasks by status. You can select or deselect options to see lists of...Your pending tasksYour ongoing tasksCompleted tasksAny combination of theseStep 5: done!We’ve created a simple Excel to-do list that can help you keep track of all your
tasks.You can edit fields, add as many columns as you want, or add custom colors and fonts to make it reflect your needs.Get startedWe recommend something different, however. If you just want a basic, free (if you already have Microsoft Office) way to organize and manage your day-to-day life, Excel is fine.The advent of project management
software has enabled us to get creative, whether you want to build a simple daily or monthly to-do list, or if you prefer sortable, drop-down lists.Despite being more complicated than it should be, it does the job. And it’s free — if you have Microsoft Office.When you’re working on even slightly more complicated tasks or projects, you'll find that you
need additional features to manage your master list.You’ll need the ability to, at the very least, share tasks with other people. You’ll need to add due dates, visualize your progress, upload project information and share files easily and communicate with your team.For all of these and more, you’ll need a versatile task management system that can help
you juggle multiple to-do lists with ease and convenience.monday.com Work OS is a visual workflow platform that helps teams manage and track any kind of work in a single place.Here’s how you can create a to-do list on monday.com.Step 1: Create a boardA board is a central location to organize your work, in this case, your to-do list.Step 2: Choose
one of our pre-loaded templatesFor a to-do list, we have the “weekly to-do list” template, as well as hundreds of other customizable options to choose from.Step 3: Create your groupsEach board consists of groups that can indicate different phases of a project, whether it’s weekly iterations or interview processes.Step 4: Add your columns.This can
include options such as task, owner, deadline, status update, dates, rating, or tags.Step 5: Add your list of tasks on your board.Simply assign tasks, update information and collaborate with team members — all within the same space.It only takes a few clicks to get started with the easy and intuitive system. Once you visualize your workload with
monday.com’s stellar features, we promise you won’t go back.Here are just a few advantages of using the monday.com Work OS to-do list functionality:The drag and drop functionality makes it super easy to organize your daily tasksCommunicate and collaborate better with your team by adding comments, sharing updates, and uploading documents in
real-timeVisually track your progress and manage your team with a bird’s eye viewAutomatically notify the next person responsible when a stage of a project is completed.Make your workflow seamless with dozens of integrations with commonly-used apps and tools.Check out our weekly to-do list template to get started.Get startedHow to import from
Excel to monday.com Work OSIf you've decided to make the switch to monday.com, you’'ve made a great choice!lt easy to get started and transfer your Excel data to monday.com Work OS:Step 1:Click your profile picture on monday.com Work OS and select Import data, then Excel:Step 2: Drag and drop your file into the screen (or browse and select
it from your computer). You'll see a dialog box notifying you that it’s done.Step 3: Select the row in your spreadsheet that will serve as the headings for your new board. Click Next.Step 4:Select the column in your file which will be the first column on your new board. Click Next.Step 5: If you need to, you can change the Column type by clicking the
drop-down menu on each column.Initially, you can import columns as status, number, date, email, or text column. You can update this only after you import your data.Click Create Board.You should now see your Excel data imported to the Work OS.You’'ve got some thinking to doYou can see that Excel can be a basic tool for task management that
doesn’t require much complexity or collaboration.In contrast, monday.com can really make a difference when you want a more dynamic and intuitive experience across teams and priorities. Whether your project or team is big or small — or anything in between — monday.com makes managing your task list an absolute breeze.So go on, give the Work
OS a go, you’ll not only have an Excel checklist template, but much, much more.Get started Tech productivity blog Digital Streets has written up a tip on how to view two Excel worksheets at once:When you have two workbooks open at the same time, select Window, Compare Side by Side With. After you select this command, a floating Compare Side
by Side toolbar will open in Excel.Simple and effective. What are your best Excel productivity tips? Let us know your thoughts in the comments. Viewing Excel Worksheets Side-by-Side [Digital Streets] Learning how to create a checklist in Excel is a game-changer for many people. Making a checklist will help you keep track of many everyday things.
For instance, a checklist can help you remember what to bring in your travels or the ingredients available when cooking a recipe. However, not everyone is well-versed in spreadsheets and may find it tough to create a checklist in Excel. This post will discuss how to make a checklist in Excel, plus some pointers on integrating it with other spreadsheet
features. How to Create a Checklist in Excel The first step in creating a checklist is coming up with a list of items or activity that needs to be confirmed. Here’s what you should do on the Excel spreadsheet: To open Excel, click on the search button next to the Start menu. Type “Excel” and click on the first result. On a new spreadsheet, type the name
of the checklist in one of the cells, preferably in A1, so that it will be easy for you to know what the list is about. Select a column where you will list the items (example: A column). Then, click a cell where you want to put the first item or activity and type it. Type in the rest of the entries on the succeeding cells of the column. Next, select a column
where you are going to put the checkbox. We’ll put it in column B in this example since it’s next to our listed entries. Then, proceed with the instructions below. How to Use Checkboxes in Excel Here’s how to make a checkbox in Excel which you can tick to indicate that the entry is completed: Check if you have the Developer tab on the Microsoft
Excel toolbar. If not, click File. Scroll down and click Options. Then, click Customize Ribbon. Head to the right side of the panel and tick the Developer box before clicking OK. Click the Developer tab. Click the Insert icon, and under Form Controls, select Checkbox. Select the cell where you want to place the checkbox, preferably next to an entry on
your list. You can change the text on the checkbox by deleting the default checkbox text and typing a word or phrase or removing the text entirely so that only the tick box remains. If you want to move the checkbox, drag it to the position you want. To copy the exact checkbox on the succeeding cells, click on it. Then, hover your mouse to the lower
right corner of the box and drag it downwards (or to any direction where you want to place the checkboxes). Important tip: When formatting a checkbox on a cell, hold the Ctrl key and press left-click to modify or resize the shape of the checkbox instead of ticking it. How to Link Cells in an Excel Checklist 1. If you want to tally the boxes ticked, link
the checkbox to another cell. 2. Right-click a checkbox and select Format Control. 3. Go to the Control tab. Head over to the Cell Link option, type the Cell name you want to link. You'll notice that if you tick the checkbox, the linked cell will display TRUE. Unchecking it will produce FALSE. 4. Repeat steps 1 and 2 to the other cells in the column that
must be linked. 5. To get a summary of how many boxes were ticked, click a cell where you want the results displayed. Then, type =COUNTIF(C4:C10,TRUE). Replace C4:C10 with the beginning and ending cells of cell range. 6. If you want to hide the column where the TRUE/FALSE values are displayed, click on the column (example: column C).
Next, press right-click and select Hide at the bottom of the popup menu. Modify Your Excel Checklist Using Conditional Formatting Conditional formatting of your spreadsheet can help your data stand out and make it visually appealing. 1. Select the cell you want to modify, then click the Home tab. Go to the right side of the toolbar and click
Conditional Formatting. 2. Select New Rule. It will show several rule types which you can use to edit the selected cell. For now, choose Use a formula to determine which cells to format. 3. In the text box below, Edit the Rule Description type =$C4. Next, select Format and then select Fill. Go to Color and change the font color of the cell (example:
Green). Select OK. Note: Don’t forget to modify the cell name. What we used here (C4) is just an example. 4. Notice that when you tick the linked checkbox next to the cell, the text will turn green. 5. Repeat steps 1-4 for the rest of the entries. Important Tip: Press Ctrl + Shift key and drag the cell to where you want to duplicate the checkbox to
produce the same result of copy-pasting. This method will also keep the checkboxes aligned. ¥ How to Make an Interactive Excel Checklist If you want to track your progress on your recipe to-do checklist, integrate the checklist into a percent of tasks completion. Here’s how you do it: Using the example we currently have, click into any cell where
you want to have the task progress to be displayed (Example: Cell E7) Type the following COUNTIF formula =COUNTIF($C$4:$C$10,TRUE). This formula will count the total numbers of entries whose checkboxes were ticked. To track the completion rate of all the entries, type this in the cell where you want it displayed (Example: Cell F4)
=COUNTIF($C$4:$C$10,TRUE)/7*100. Note: don't forget to replace “7” with the number of entries on the list. What’s in Your Checklist? Creating a checklist in Microsoft Excel can be fun and help you be excited about the activity or items you want to track. Whether you are making a grocery list or creating an inventory for your store, a checklist is
one of the best ways to avoid missing any item. Next, create a dropdown list in Excel and make it easier to enter frequently used data in a spreadsheet.
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